Video Article

Biological Sample Preparation by High-pressure Freezing, Microwave-assisted Contrast Enhancement, and Minimal Resin Embedding for Volume Imaging

Anna M. Steyer\textsuperscript{1,2}, Torben Ruhwedel\textsuperscript{1}, Wiebke Möbius\textsuperscript{1,2}
\textsuperscript{1}Electron Microscopy Core Unit, Max Planck Institute of Experimental Medicine
\textsuperscript{2}Center Nanoscale Microscopy and Molecular Physiology of the Brain (CNMPB)

Correspondence to: Wiebke Möbius at moebius@em.mpg.de
URL: https://www.jove.com/video/59156
DOI: doi:10.3791/59156

Keywords: Biology, Issue 145, Neuroscience, focused ion beam scanning electron microscopy, FIB-SEM, minimal resin embedding, high-pressure freezing, microwave-assisted processing, sample processing, 3D electron microscopy, 3D reconstruction
Date Published: 3/19/2019

Citation: Steyer, A.M., Ruhwedel, T., Möbius, W. Biological Sample Preparation by High-pressure Freezing, Microwave-assisted Contrast Enhancement, and Minimal Resin Embedding for Volume Imaging. J. Vis. Exp. (145), e59156, doi:10.3791/59156 (2019).

Abstract

The described sample preparation technique is designed to combine the best quality of ultrastructural preservation with the most suitable contrast for the imaging modality in a focused ion beam scanning electron microscope (FIB-SEM), which is used to obtain stacks of sequential images for 3D reconstruction and modelling. High-pressure freezing (HPF) allows close to native structural preservation, but the subsequent freeze substitution often does not provide sufficient contrast, especially for a bigger specimen, which is needed for high-quality imaging in the SEM required for 3D reconstruction. Therefore, in this protocol, after the freeze substitution, additional contrasting steps are carried out at room temperature. Although these steps are performed in a microwave, it is also possible to follow traditional bench processing, which requires longer incubation times. The subsequent embedding in minimal amounts of resin allows for faster and more precise targeting and preparation inside the FIB-SEM. This protocol is especially useful for samples that require preparation by high-pressure freezing for a reliable ultrastructural preservation but do not gain enough contrast during the freeze substitution for volume imaging using FIB-SEM. In combination with the minimal resin embedding, this protocol provides an efficient workflow for the acquisition of high-quality volume data.

Video Link

The video component of this article can be found at https://www.jove.com/video/59156/

Introduction

High-pressure freezing is the sample preparation method of choice for obtaining high-quality ultrastructural preservation, which represents the native state of a sample much better than conventional preparation methods using chemical fixation\textsuperscript{1}. This cryo-preparation method is useful for samples such as myelinated mouse tissue\textsuperscript{2} and a strict requirement for use of the model organism \textit{Caenorhabditis elegans}\textsuperscript{3}. After freeze substitution and resin embedding, these samples are usually analyzed by transmission electron microscopy (TEM) or electron tomography (ET). If bigger volumes must be imaged using FIB-SEM or serial block-face imaging for high-resolution large-scale 3D reconstructions, in our experience proper imaging by SEM is often hampered by the lack of contrast. In the FIB-SEM, the image is usually recorded by the detection of backscattered electrons from the primary electron beam. The yield of backscattered electrons is proportional to the content of heavy metals in the sample. Therefore, protocols were especially designed for volume imaging to enhance the contrast by additional heavy metal impregnation. Such methods are based on chemically fixed samples and apply a combination of osmium tetroxide-thiocarbohydrazide-osmium tetroxide\textsuperscript{4}, as described by Knott et al.\textsuperscript{5}, for serial block-face and focused ion beam scanning electron microscopy. Modifications including the use of formamide and pyrogallol\textsuperscript{6} or lead aspartate\textsuperscript{7} have been successfully applied for different imaging techniques.

The protocol provided here combines the cryo-preparation of specimens by HPF and freeze substitution with subsequent microwave-assisted processing for enhanced contrast using thiocarbohydrazide/osmium tetroxide in acetone at room temperature. We demonstrate this on the myelinated nervus tibialis of mice and in \textit{Caenorhabditis elegans}, which represent samples that require high-pressure freezing for high-quality ultrastructural preservation. In addition, it is shown how, after dehydration and infiltration, the samples are embedded with as little resin as possible. This minimal resin embedding\textsuperscript{8} allows for faster targeting of the structure of interest and reduces the time spent on sample processing, including less time required for exposing the region of interest with the ion beam. After performing further sample preparation steps inside the microscope, imaging and milling of the sample is carried out continuously to acquire a stack of images. For 3D visualization, image processing software (IMOD) is used to reconstruct parts of the dataset.

Our workflow describes how the most suitable contrasting of samples for volume imaging can be combined with the best ultrastructural preservation by HPF and freeze substitution. This is useful for samples that strictly require cryo-preparation. Applications are limited to small samples that can be prepared by HPF. In samples of different nature, such as plant material or microorganisms, this protocol requires adaptation.
Protocol

All experiments including samples from animals described here have been approved by the Institutional Animal Care and the Lower Saxony State Office for Customer Protection and Food Safety (LAVES).

1. High-pressure freezing and freeze substitution

1. Dissect the nervus tibialis from a mouse (e.g., C57Bl6N, 12 weeks, female)\(^9\).
2. Immerse the nervus tibialis in a droplet of 20% polyvinylpyrrolidone (1 g of PVP in 5 mL) in phosphate buffered saline (PBS) and cut pieces of 2 mm length. Then, place it in a metal sample carrier (Type A, 0.2 mm depth) using fine forceps. Add another flat carrier (Type B) coated with a thin layer of hexadecane as a lid and insert this assembly into the specimen cartridge.
3. Transfer several C. elegans suspended in a droplet of 20% bovine serum albumin (BSA) in M9 (see Table of Materials) to a disposable plastic pipette into the metal carrier (Type A). Then, add a second carrier as lid on top (Type B) and assemble the cartridge.
4. For both of the samples, proceed with the following: high-pressure freeze the sample carrier assemblies one-by-one by loading them into the three-piece cartridge in the loading station of the high-pressure freezer. Press the process button according to the manufacturer’s operating instructions.
   NOTE: Both types of samples can be processed together in the subsequent freeze substitution.
5. Place the samples into cryovials containing 2 mL of frozen 0.1% tannic acid in acetone. Perform the transfer in a bath of liquid nitrogen without spilling liquid nitrogen into the vials. Transfer the cryovials into an automatic freeze substitution unit\(^10\) set at -90 °C and start the program.
   NOTE: The samples are kept at -90 °C for 100 h. Tannic acid before osmification is used as mordant to increase the uptake of osmium tetroxide\(^11\).
6. Manually wash the samples 3x for 30 min with 2 mL of acetone at -90 °C in the freeze substitution unit.
7. Leave the samples in 2 mL of 2% osmium tetroxide, 0.1% uranyl acetate in acetone for continued staining in the automatic freeze substitution unit for 7 h at -90 °C.
   CAUTION: Osmium tetroxide is toxic and should be handled under a fume hood, and protective equipment should be worn.
   NOTE: The freeze substitution unit automatically raises the temperature to -20 °C at 5 °C/h. The samples are kept at -20 °C for 16 h in the freeze substitution unit. The temperature will be raised automatically to 4 °C at 10 °C/h.
8. Exchange the osmium tetroxide solution with pure acetone when the temperature has reached 4 °C. Remove the cryovials from the freeze substitution unit.

2. Microwave-assisted processing

NOTE: Perform all of the following steps at room temperature\(^12\) using a temperature control unit to keep the temperature stable (see Table of Materials).
1. Leave the caps of the reaction tubes open during processing in the microwave.
2. Take the metal sample carriers out of the cryovials and remove the samples from the metal carrier using fine forceps or a needle, while keeping the samples submersed in acetone in a watch glass dish (150 mm).
3. Transfer the samples into 2 mL reaction tubes using fine forceps or a pipette and wash with 1 mL of acetone four times for 40 s at 250 W.
   CAUTION: Thiocarbohydrazide is toxic and should be handled under a fume hood, protective equipment should be worn.
4. Stain the samples in 2 mL of 1% thiocarbohydrazide in acetone for 14 min at 150 W to increase the contrast. To perform the staining, pipette the thiocarbohydrazide solution into the reaction tube, place the tube in the microwave, and set the program to a power level of 150 W (with the vacuum function turned on) for 2 min on/2 min off, iterating for 14 min total. Start the microwave.
   NOTE: Thiocarbohydrazide reacts with the osmium tetroxide that was applied during the freeze substitution. It forms a bridge, allowing more osmium tetroxide to be deposited onto the original osmium tetroxide sites\(^13\).
5. Wash the samples 4x with 1 mL of acetone for 40 s at 250 W. Pipette the acetone into a reaction tube, place the tube into the microwave, and select 250 W for 40 s. Start the microwave.
6. Stain in 1 mL of 2% osmium tetroxide in acetone for 14 min at 150 W. Pipette the osmium tetroxide solution into a reaction tube, place the tube into the microwave, and set the program to a power level of 150 W (with the vacuum function turned on) for 2 min on/2 min off, iterating for 14 min total. Start the microwave.
7. Wash the samples 4x with 1 mL of acetone for 40 s at 250 W (as done in step 2.5).
8. Infiltrate with 1 mL increasing concentrations of resin in acetone (see Table of Materials) of 25%, 50%, 75%, 90%, 100%, and 100% for 3 min each at 250 W. Pipette the resin into a reaction tube, place the tube into the microwave, and set the program to a power level of 250 W (with the vacuum function turned on) for 3 min. Start the microwave.

3. Minimal resin embedding\(^8\)

1. Take the nervus tibialis and C. elegans out of the reaction tube with a toothpick and place them on a piece of plastic film (see Table of Materials).
2. Use the toothpick to gently push the sample around on the plastic film until no remaining resin is detected. Use a halogen lamp for heating (see Table of Materials) so the resin becomes less viscous and is able to be removed more easily. Place the halogen lamp close enough to heat up the resin (being careful not to burn hands).
3. Polymerize the samples for at least 48 h at 60 °C on top of the plastic film in the oven.
4. Preparation for FIB-SEM

1. Cut out the polymerized samples together with the plastic film using a razor blade at a size fitting the SEM stub and attach them to the SEM stubs using a conductive silver resin (see Table of Materials). Polymerize again at 60 °C for at least 4 h or overnight.
2. Sputter coat the samples on the SEM stub with gold for 1 min at 35 mA using a sputter coater (platinum/palladium can also be used; a 10 nm thick coating is sufficient) and place them inside the FIB-SEM.

5. Data acquisition inside the FIB-SEM

1. Image the samples with the secondary electron detector using the basic software driving the microscope (see Table of Materials). The sample should be oriented so that the region of interest (e.g., middle part of the nervus tibialis or the C. elegans) is in the field of view.
   NOTE: To perform the data acquisition, tilt the stage to a position so that the sample faces the ion beam at a 90° angle at an appropriate working distance (5 mm) in the so-called coincidence point of the ion and electron beam. Using our instrument, this is achieved at a stage tilt of 54° and 5 mm working distance.
2. To set up the correct position of the sample, center a common feature at a 0° tilt while imaging with the secondary electron detector. Slowly tilt to 54° (5°, 20°, 54°), recentering the same object by moving the M-axis.
3. Find the coincidence point by centering a feature while imaging with the secondary electron detector at 54°, followed by moving the feature to the central position in the FIB mode. Perform this by displaying the crosshairs in the SEM software to have an indication of the center. Then first move the selected sample feature to the center of the image area by using the center point function of the SEM software. Then center the feature along the y-axis by moving the stage in z. Any final offset between FIB and SEM is corrected with the SEM beam shift.
4. Open the advanced software (see Table of Materials) for recording 3D datasets and follow the software wizard step-by-step.
5. At the region of interest, deposit carbon or platinum (400 nm) on top of the ROI using a 3 nA current to allow even milling and reduce artifacts induced by charging.
   NOTE: By drawing the region of interest to be milled on the specimen surface imaged with the FIB (width, height, depth), the software calculates and superimposes the sizes of the different sample preparation features, such as the trenches to be milled or area for platinum/carbon deposition. Also, be cautious of imaging the sample surface with too-high FIB currents, as this can damage the sample surface. A current of 50 pA is sufficient for imaging.
6. Use the focused ion beam to mill a trench to expose the region of interest (ROI) using a 15/30 nA current.
7. Use the focused ion beam to polish cross-section with a 7 nA current.
8. After finishing the sample preparation, set up the following imaging parameters: FIB milling parameters in the FIB setup tab (FIB milling current); SEM imaging parameters in the setup tab and the image tuning parameters in the SEM AutoTune tab (perform autofocus and autostigmation every 60 min, 50 nm pixel size, dwell time 3, line average 3). Optimize this for every sample.
9. To prevent any thermal drift causing the block-face to drift during the run, leave the room for at least 2 h before starting the acquisition.
10. Acquire the dataset in a continuous mill and acquire mode with a 700 pA FIB current. Use 1.5 kV (analytic mode, 900 V) ESB detector with a grid voltage of 400 V to acquire images each with 5 nm pixel size using the advanced software (see Table of Materials) and 50 nm slice thickness. One image acquisition takes about 1.5 min with a dwell time of 6 µs.
11. Start the data acquisition. A FIB image at the milling current is acquired to ensure that the sample did not move and the right region of interest is selected. Adjust if necessary.

6. Data visualization

1. Open images in Fiji by dragging the folder containing all the images into Fiji and select Virtual Stack.
2. Crop the region of interest using the rectangle tool (Image > Crop).
3. Invert the data to show the traditional transmission electron microscopy contrast with membranes showing up in dark (Edit > Invert).
4. Use TrackEM2 (Fiji) for alignment. Load the data into TrackEM2 (File > New > TrackEM2) by clicking on layer. After all images are loaded, align them using multi-layer mosaic function (right-click on Image > Align > Align multi-layer mosaic). After alignment, the images are exported as individual tiff-files (right-click on image > Export > Make flat image). Select all images that should be exported and choose save to file.
5. For post-processing, use a Gaussian blur (Process > Filters > Gaussian blur; sigma 2) and local contrast enhancement (Process > Enhance Local Contrast; CLAHE: blocksize 127, histogram bins 256, maximum slope 1.5), which are applied in Fiji to smooth the image and obtain a better signal-to-noise ratio.
6. IMOD is used to perform a manual segmentation and visualize the structure of interest in 3D. Open the dataset in IMOD and select Drawing tools (Special > Drawing Tools) to perform the manual segmentation. Different manual tools can be used to follow the structure of interest throughout the volume (for example Join, Sculpt). Use Microscopy Image Browser (MIB) for semi-automated segmentation.

Representative Results

The workflow starts with a sample (here, a freshly dissected mouse nervus tibialis) being placed in metal carriers for high-pressure freezing (Figure 1a). The carriers are recovered from liquid nitrogen (Figure 1b) and placed in a freeze substitution unit on top of the frozen first chemical cocktail (Figure 1c). After a long freeze substitution protocol including 2% osmium tetroxide and 0.1% uranyl acetate, the samples are removed from the carriers at room temperature (Figure 1d). To further enhance the contrast, the samples are transferred to plastic tubes to be processed in the microwave (Figure 1e). The vacuum chamber and temperature control unit are used to optimize the process (Figure 1f).
To be able to perform the minimal resin embedding, toothpicks and sheets of plastic film are needed (Figure 2a). After infiltrating the samples with resin using the microwave, they are placed on pieces of plastic film and moved around until no resin is left on the sample surface. A halogen lamp is used to help drain the remaining resin and leave the sample minimally embedded (Figure 2b) on the plastic film. It should be noted that more resin removed from the top of the sample is good. There should still be a small amount left underneath the sample to keep it attached to the substrate. The sample being polymerized on the plastic film is cut and mounted on top of SEM stub with silver conductive resin (Figure 2c). The stub is polymerized for at least 4 h at 60 °C (Figure 2d). The components should be mixed thoroughly or the mixture may not polymerize correctly. To avoid charging inside the scanning electron microscope, the stub is sputter coated with gold or platinum/palladium (Figure 2e).

The samples are placed in the FIB-SEM and imaged with a secondary electron detector to target the region of interest (Figure 3a,e). An ion beam is used to remove material directly in front of the region of interest to expose a cross section (Figure 3b-d, 3f-h). Standard protocols often suffer from a lack of membrane contrast (Figure 3b,f), whereas the enhanced protocol provides a strong membrane contrast (Figure 3c-d, 3g-h).

The EM data (after post-processing) are visualized using IMOD, an image processing and modelling program. To achieve a better understanding of the 3D information, virtual reslicing of the data is used (Figure 4a). Different structures of the dataset are segmented manually (Figure 4b-d).

Figure 1: High-pressure freezing, freeze-substitution, and microwave-assisted processing. (a) Sample carrier containing the mouse nervus tibialis, scale bar 3 mm. (b) Sample carrier containing the mouse nervus tibialis after high-pressure freezing, scale bar 3 mm. (c) Automatic freeze substitution (AFS) unit with samples. Inset: custom-made metal container for up to 23 sample vials and two large vials containing chemicals in the AFS. (d) Samples being removed from carriers in a glass dish in acetone, scale bar 3 mm. (e) Samples in reaction tubes to be put in the microwave for processing. (f) Vacuum chamber and temperature control unit of the microwave. Please click here to view a larger version of this figure.
Figure 2: Minimal resin embedding and preparation for the FIB-SEM. (a) Plastic film and toothpicks that are used for the minimal resin embedding, scale bar 4 cm. (b) Nervus tibialis drained of resin on top of the plastic film, scale bar 250 µm. (c) Nervus tibialis polymerized on plastic film, then cut and mounted on top of the SEM stub with silver conductive resin, scale bar 250 µm. (d) Samples polymerized on top of the SEM stub, scale bar 3 mm. (e) Samples coated with gold on the SEM stub, scale bar 3 mm. Please click here to view a larger version of this figure.
Figure 3: Preparation of the sample inside the FIB-SEM. (a and e) Secondary electron image inside the FIB-SEM of the sample surface (a) Nervus tibialis, scale bar 100 µm. (e) C. elegans, scale bar 2 µm. (b-d) and (f-h) Cross-section through sample using ESB detector for imaging. (b and c) Nervus tibialis, scale bar 2 µm. (f and g) C. elegans, scale bar 1 µm and 200 nm. (b and f) Shown are the results of high-pressure freezing and freeze substitution without enhancement, whereas all other images show results of enhanced freeze substitution. (d and h) Detailed image of the sample using the ESB detector. (d) Nervus tibialis, scale bar 200 nm. (h) C. elegans, scale bar 200 nm. Please click here to view a larger version of this figure.
Discussion

The protocol was developed to illustrate the optimal preservation and contrast to perform serial block-face imaging with a FIB-SEM. Therefore, we chose to apply cryo-immobilization followed by post-staining using freeze substitution and microwave-assisted processing. Therefore, this protocol is limited to samples that are small enough for high-pressure freezing. The size limitations of 3 to 6 mm in width and thickness of ~200 µm are established by the size of the sample carrier, which matches the sample size that can be properly frozen with this technique. This is relevant for the mouse nerve sample, since the sciatic nerve is too large in diameter to fit into the 0.2 mm carriers that are required to ensure proper freezing. Therefore, careful dissection of a smaller nerve such as the tibial nerve or other thin nerve such as the femoral nerve is recommended. Since the myelin sheath is sensitive to stretching, great care must be taken during dissection of the fresh and viable nerve to avoid handling artifacts. In general, only viable samples should be used for electron microscopic studies.

Microwave-assisted processing and minimal resin embedding are designed for speeding up the preparation and targeting process. The microwave-assisted processing applying a modified OTO protocol is used for room temperature chemical fixation. A household microwave will not yield the same results, since there is no homogenous distribution of microwaves, its temperature is not controlled, and there is no vacuum that can be applied. The smaller a sample, the better penetration of the chemicals; therefore, the best results are achieved by smaller samples. To avoid damage to the sample by overheating, temperature control and application of the minimally required microwave power are critical. The microwave-assisted processing steps can be performed on the bench if there is no microwave available, which will lead to longer processing times. To directly target structures in the SEM, it is crucial to remove as much resin as possible from the top of the sample. After recording a dataset, post-processing of the raw data is necessary to reduce file size and improve the signal-to-noise ratio. Modern volume imaging techniques produce large amounts of data. Therefore, to perform the data processing in a fast and sufficient manner, sufficient RAM on the workstation is needed. For alignment operations at least two times as much RAM as the dataset size is required.

This protocol has been tested on the nervus tibialis of the mouse as well as in C. elegans. Hall et al. used a similar enhancement step after their freeze substitution on the bench for preparation of C. elegans. For any other model organism such as the zebrafish, adjustments of the protocol are likely necessary. One possible modification is to change the composition of the freeze substitution cocktail, such as by the addition of water that is used for contrast enhancement. Moreover, the duration of the freeze substitution has to be adapted to the sample and can be considerably shortened according to the quick freeze substitution protocol. One possibility is the application of agitation for accelerating the freeze substitution process. After the freeze substitution, further modifications are possible, such as repeated application of enhancing chemicals and osmium tetroxide. During microwave processing, the temperature, incubation times, and power settings can be varied to optimize results for the respective sample.
This protocol shows that such an enhancement can be combined with other freeze substitution protocols and different types of samples as described by Hall12 that are imaged in a FIB-SEM or by serial block-face scanning electron microscopy. These imaging techniques require enhanced contrast, which is less important for transmission electron microscopy.

Disclosures

No conflicts of interest declared.

Acknowledgments

The FIB-SEM and A.S. (the position of the FIB-SEM operator) are funded by the Cluster of Excellence and Deutsche Forschungsgemeinschaft (DFG) Research Center Nanoscale Microscopy and Molecular Physiology of the Brain (CNMPB). We thank the lab of Thomas Müller-Reichert for providing the C. elegans samples. We thank Ulrich Weikert for participating in the movie.

References